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Data Transfer Overview

» Uses the iSeries database server to transfer data to and from DB2
database files and iSeries source physical files

* Provides an SQL-like interface to allow full file SELECT or customized
queries including joins, sorting, and record grouping

» Capable of transferring data to and from many popular PC file types
including ASCII Text, CSV, Excel types, Tab-Delimited Text, Lotus 123,
and others

* Provides access to iSeries file members

* Transfers may be run interactively, in batch mode, programmatically, or
directly from Microsoft Excel
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@server’
Data Transfer Overview

Data Transfer is limited to transferring source physical files and data physical
files to PC file types and PC file types to the source and data physical files on the
iSeries. Transferring other types of files to and from a PC and the iSeries
requires using other methods. Some other types of files that reside on the
iSeries are stream files or flat files such as those stored in the Root or NetWare
portions of the iSeries Integrated File System. These files may be accessed
using the methods listed below.

iSeries NetServer through 'shares'

iSeries Navigator Integrated File System (IFS) support
File Transfer Protocol (FTP)

The IBM Toolbox for Java IFS classes

iSeries Access for Web

e o o o o
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Components of a Data Transfer

Supported transfer request file types

= - Data Transfer From iSeries

Data Transfer

sta T — .DTF - New request type used in iSeries Access
SSSSSS — .TTO - Request type used in XD1 and DOS Extended clients
— .DT - Request type used in Windows 3.1 client
— .RTO - Rumba transfer request file
» Data Transfer To iSeries
DTHSF — .DTT - New request type used in iSeries Access
e — .TFR - Request type used in XD1 and DOS Extended clients

— .DT - Request type used in Windows 3.1 client
— .RTO - Rumba transfer request file
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Data Transfer Usage

- Basic Data Transfer

* Running Data Transfer by Clicking an Icon
» Scheduling Data Transfers

* Using the Excel Add-in

» Using Data Transfer with a Web server

* Using the Data Transfer Query Builder

* Tips and Tricks with Data Transfer
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Basic Data Transfer

Upload file to iSeries
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Basic Data Transfer

Setting up the library list

Data Transfer To iSeries [_ICTx]
Fle Yiew Took Help

2EEE E

| Properties [ 7] =]
File name: Corwersiorss  Library List |D|sp\ay| Connection | Startup |

These libraries are temporarily added to the iSeries job brary
feies——— list while this data tansfer request is used

Syster: iSeries library: |GIWS Add |

& Begiming ¢ End

Optional: To aid us
when we are looking
for files, we need to
add the libraries to
the library list.

Library/File[Member)

, Libray N [T [= A
To set properties go e Usar [ o |
to the File menu and Qb Svtem
- ODEVELDP Syt
select Properties. Transter | @BLDSYS Stem T
QBLDSYSR System |
T
ok | cancel | s | Hew |
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Basic Data Transfer

What is the iSeries Database File Wizard?

* The wizard creates a:
— File Description File (FDF)
— Database file on the server
* The wizard does not do the actual data transfer to the iSeries
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Basic Data Transfer
Starting the iSeries Database File Wizard
Data Tran_fer To iSeries [_[C1x] |
File View ToolNHelp
LRI

Start the Create
iSeries Database
File tool by
selecting it from the
Tools menu or by
clicking on its icon
in the toolbar

PC
File name:

iSeries
System:

Library/File[Member

Welcome

This wizard allovs you ta create an iSeries database
file: from an existing PC file.

“rou will be required to specify the name of the PC
file: from which the iS eries file wil be based. the:
name of the iSefies file which to create, and several
ather necessary details.

ek [[THat ] cancel | Hep |
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Basic Data Transfer

Selecting the PC file that contains your data

Create iSeries Database File [ x]

PC File Mame

“what is the name of the PC file which contairs your
data?

Eile name:

Browse

< Back I Mext » I Cancel Help
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Basic Data Transfer

Selecting the PC File Type

Create iSeries Database File [ ]

File Type:

\what is your PC fle type?

Eile type:
123 [Latus]

< Back I Hext > I Cancel Help
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Basic Data Transfer

The File Description File panel

Create iSeries Database File [ ]

Create File Description File

‘what is the name of the file description file pou
would ke to create?

Browsse

< Back I Hext > I Cancel Help

©2005 IBM Corporation

iSeries [i[7] DEMAND BUSINESS®
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Basic Data Transfer

The Change Data Format Options panel

Create iSeries Database File [ x]

Change D ata Format Options

To propely ereate an iSeries database il the conect
format of your data must bs provided

Options such as date format and decimal separatar
st b set b match your data

If these options are not changed, default values are
used. This could result in data corruption or failure
when transfering data to the new database file.

Ta set the praper famat options for pour data, press
Formnat Optians.

Fomat Options.

<Back [ Wewr | canca | Hep |
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Basic Data Transfer

The Scan PC File panel

Create iSeries Database File [ ]

Scan PL File

To create an iSeries database file the PC file
must be scanned to deteming its data layout

Selsct Start Soan ta begin the scan

| Start Scan |

¥ Eirst ro

< Back I Mext > I Cancel Help
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Basic Data Transfer

The Contents of PC File panel

Create iSeries Database File [ x]

Contents of PC File

Eielow is a list of fields which the scan operation
determined the PC file contained. These field
definitions will be: used to craate the iSeries File.

Field \ Tupe | Length\ -
CUSNUM NUMERIC 3
LETHAM CHARACTER a

INIT CHARACTER 3 —
STREET CHARACTER 12

ary CHARACTER E
STATE CHARACTER 2 ~
4 »

Details...

<Back [ Wewr | cancal | Hep |
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Basic Data Transfer

The Field Details panel

Field Details [ 2] x]
Mame: W
Deseiptior: |
Type [cHeRacTER =1
Length: 8 3 Allocate: o 3
Sode [T H padhg [T

CCsID “DEFALLT

Default I“DEFALILT

I~ Null capable

¥ Include in file description file

ok | cencel | Help
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Basic Data Transfer

The System Name panel

System Hame

“wihere should your database file be created?

Create iSeries Database File [ x]

[Series server
|MYSYSTEM| =l
<gack [ Het> | Cancel Help
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Basic Data Transfer

The iSeries File and Library panel

Create iSeries Database File

iSeries File and Library

Ywhat is the name of the file which wil contain
your data? For example, TESTLIB/TESTFILE

The file you spesify must ot alieady exist in the
specified library and you must have authority to
wiite to the ibray.

Library/File:

Browse

< Back. I Hext > I Cancel Help
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@server’

Basic Data Transfer

The File Description Text panel

Create iSeries Database File [ x]

File Description Text

“fou can associate a line of text with the file which
deseiibes the contents of the file.

File text

My customer infarmatior]

<Bsck | Met> | Cancel Help
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Basic Data Transfer

The Confirm Create Options panel

Create iSeries Database File

Confirm Create Options

iSeries server:
IMYSYSTEM

LibranyéFile:
WD:CUSTDMEH

PC file description file:

Select Next to create the iSeriss database file and
the PL file description file.

< Back. I Mext > I Cancel Help
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Basic Data Transfer

The final panel - your file has been created!

Create iSeries Database File [ x]

Congratulations!

“ou have successtully created an iSeries database
file.

Use Data Transfer To iSeries to anster data from
your PC file to the new database file.

Press Finish to retum to Data Transfer To iSeries.

< Back Cancel Help
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Basic Data Transfer

Returning to Data Transfer To iSeries

The PC file we used as a i8 Data Transfer To iSeries I B
model

File Wew Took Help

e I

PC N
The |Ser|es System we ’7 File name: C:htemphdiransfercustomer 123 Browse.

created the file upon

Syster:  [MYSYSTEM -
Library/File{Member]
[INFO/CUSTOMER: Brawse...
Detals..

The Library/File name of

our new file —
[ Transfer data to Series |
=
Click to transfer datato ~ _——
your new file
© 2005 IBM Corporation q .
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Basic Data Transfer

Key points about the iSeries Database File Wizard

 Creating the table and FDF does not do the data transfer.
* Plan ahead by increasing lengths if necessary.
* Do not include character and numeric data in the same column.
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Basic Data Transfer

@server’

Data Transfer to iSeries: Specifying iSeries File Details

:8 Data Transfer To iSeries
File View Took Hslp

B

FC
’7 File name: C:htemphdtransfericustomer. 123 Browss.

iSer
System:

MTSTSTEM >

Library/Fils(Member]

|\NFD/CUSTDMEH

Browse..
Details...

Transter data to iSeries |
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@server’
Basic Data Transfer
Data Transfer to iSeries: iSeries File Details - upload options
iSeries File Details [ 2] x]
Source Physical files jen
« Select not to use an FDF file Elle:ama' IIZ'\lamp\dtlansler\:ustnmel FOF Browse. ..
«Select the proper file type File e [Eeen Tent =
«Select the record length, file Tondatstor: [e0l =] tweBcoc

and member text and authority
on create

Data Physical files

+«Use a PC FDF file

«Select Field Reference File, file
and member text, and authority
when creating new files

Eoded Character Seb0:

- iSeries fi

Create iSeres object No, replace member only ~
e text

iGeries file bpe: & Data  Source

Field reference file name: Brawse
Fecord lerath: 92 3:

Auithorty Read/wite B
File text:

0K | Cencel | Hep |
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Data Transfer Usage

* Basic Data Transfer

* Running Data Transfer by Clicking an Icon
» Scheduling Data Transfers

* Using the Excel Add-in

» Using Data Transfer with a Web server

* Using the Data Transfer Query Builder

* Tips and Tricks with Data Transfer
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@server’
Running Data Transfer by Clicking an Icon

Saving the request

Data Transfer To iSeries

S
. . . Ele Wew Took Help
->
Clicking File->Save As allows B W a
you to save the request.

PC.
’V File niame: C:\emphdiransfericustomer. 123 Browse...

System: M5 YSTEM b

Library/File{tember]
|INFD/EUSTDMEH

Browss
Details

| Transter data to iSeries I
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@server’
Running Data Transfer by Clicking an Icon
Auto-run/Auto-close support
[Praperties 21|
CI|Ck|ng FiIe->Pr0pertieS allows Eanvelsians] IJblalyLi:lI Disp!ayl soL | Connection ~ Startup
you to customize properties Request optio
related to this data transfer.

¥ Fiun tiansfer request automatically

¥ Close on completion

OK I Cancel |

©2005 IBM Corporation
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Help |
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Running Data Transfer by Clicking an Icon

Running by double-clicking the icon

& dtransfer

[_[o]=]
Fle Edt Vew Favortes Took Help ‘ﬁ

Gack + = - &) | @search [y Foiders (3 |

=
Address [l Ciitemplctransfer x| P
|

customer. 123 customer.FOF [y

Transfer statistics:

Rows transferred:

‘9
A
Q.7
Type: Data Transf [474 bytes [\ My Computer
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Running Data Transfer by Clicking an Icon

Batch transfer command interface

* RTOPCB

— Does batch data transfers from iSeries to PC
* RFROMPCB

— Does batch data transfers from PC to iSeries
* RXFERPCB

— Does batch data transfers from iSeries to PC

— Does batch data transfers from PC to iSeries
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@server’
Running Data Transfer by Clicking an Icon

Data Transfer from iSeries: Batch transfer command interface
RTOPCB [/S] [[/I] [filename [/C] [...] ] | [[I] /F list file] ]
/S Show transfer statistics.

filename An iSeries to PC transfer request (.TTO or .DTF),
Rumba (.RTO), or Windows 3.1 (.DT) file transfer

request.
/C Process next file independent of previous file.
Nl Ignore warnings.
/F Process files within list file (one filename per line).
list file A file containing a list of transfer files to process.
Examples:
RTOPCB c:\templ\test.tto

RTOPCB /S c:\temp\test.tto /C c:\temp\trans.dtf
RTOPCB /S /F c:\temp\transfer.dtf

©2005 IBM Corporation
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Running Data Transfer by Clicking an Icon

Data Transfer to iSeries: Batch transfer command interface
RFROMPCB [/S] [[/I] [filename [/C][...]1]|[/1] [/F list file] ]

/S Show transfer statistics.
filename A PC to iSeries file transfer request (. TFR or .DTT),
Rumba (.RTO), or Windows 3.1 (.DT) file transfer request.
IC Process next file independent of previous
file.
IF Process files within list file (one filename per line).
list file A file containing a list of transfer files to process.

Examples:
RFROMPCB c:\temp\test.tfr

RFROMPCB /S c:\temp\test.tfr /C c:\temp\trans.dtt
RFROMPCB /S /F c:\temp\transfer.dtt

©2005 IBM Corporation
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Running Data Transfer by Clicking an Icon

Data Transfer between iSeries: Batch transfer command interface
RXFERPCB request userlD password

request - Fully qualified file name of any Client Access upload or download
request of type .DTF, .DTT, .TTO, or .TFR.

userlD - A valid iSeries user profile for the system specified in the request.

password - A valid password for the specified user profile.

Examples:
RXFERPCB c:\temp\upload.dtf myuserid mypassword

RXFERPCB c:\temp\download.dtt myuserid mypassword

©2005 IBM Corporation

iSeries [i[7] DEMAND BUSINESS®
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Running Data Transfer by Clicking an Icon

Shortcut to the Data Transfer command line interface
Update Customers Propetties

To create a new shortcut: General  Shaiteut | Options | Fort | Layout | Colors | Sesuity |

T e o

= Right click on an open area of Windows

Explorer (or My Computer) Tagelpe,  Applcation

» Select New -> Shortcut Tt (Ol e

= Find and select the RXFERPCB, RTOPCB, Tz [ Frogram Fiss\ 31 Clint Acossshiiompeb sve”
or RFROMPCB program in the Client Access T
Folder

» Name the shortcut Stattin [FE Frogiam Fles EH et fccess”

= Right click on the new shortcut and select Shorteut key: [Flone
properties from the menu -

= Add the full path of the transfer request to run Comere |
aﬂer the Command Find Target LChange |con. I

= Select to run minimized

’D—KI Cancel | Apply |

©2005 IBM Corporation
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Running Data Transfer by Clicking an Icon

Running by double-clicking the icon

&0 dransfer =1 &3
Fle Edt Wiew Favortes Tools Help |ﬁ
Gack - b - @] | @search [HFoders )
Agdress [ Ciitempigtransher -] #a

B - L Data is updated.
= A

No prompts!

cuskomer, 123 customer FOF  mycustome, . Update
(Customers}

|4 object(s) le.35 K8 &, My Computer v

©2005 IBM Corporation
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Data Transfer Usage

» Basic Data Transfer

* Running Data Transfer by Clicking an Icon
» Scheduling Data Transfers

* Using the Excel Add-in

» Using Data Transfer with a Web server

* Using the Data Transfer Query Builder

* Tips and Tricks with Data Transfer

@server’
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Scheduling Data Transfers

Add a scheduled task

* iSeries Access for Windows
does not provide a scheduler
program. For this example, we
use Microsoft's Task Scheduler
application.

* To access Microsoft's Task
Scheduler, go to your Control
Panel, select Scheduled Tasks,
and select Add Scheduled Task.

Scheduled Task Wizard [ x]

@server’

This wizard helps you schedule a task for Windows
to perform,

*fou select the program you want Windows to run,
and then schedule it for a convenient time:

Click Mext to continue:

Cancel

©2005 IBM Corporation
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@server’
Scheduling Data Transfers

Choose the application to schedule

* Click Browse

+ Choose the RXFERPCB.EXE,
RTOPCB.EXE or

Scheduled Task Wizard [ ]

Click the program you want Windows ta run.
To see more programs, click Browse.

pplication [ wession [=]
caobat Readsr 4.0 415 —
RFROMPCB.EXE program BB sctivei Cartircl Test Container 60,8063
: [ Avrsss Bnk 5.0 280011
located by default in: P2 iddress Book Palm Sync Instal 1,0,0,5

[E :ddress Book Palm Sync e, 4.72.0.25
(&) ADSM Backup Client 3.1.0,1
e =l

B ]

C:\Program Files\IBM\Client Access

< Back Hext> | Cancel |
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Scheduling Data Transfers

Choose how often to run the task

Scheduled Task Wizard [ x]

Type & name for this task. The task name can be
the same name as the progiam name

[Update Customers Daily

Perform this task:

i« Daily

" leekly

© Monthly

" One time only

€ Wwhen my computer starts
© Wwhen| Jog on

< Back I Mest > I Cancel
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@server’
Scheduling Data Transfers

Choose the time to run the task

Scheduled Task Wizard [ ]

Select the time and day you want this task to start

Start time:
2008M =

Perform this task.

% Every Day

 Weekdays

CEvey [I = s
Start date:

9/ 7/2003  x

< Back I Heut> I Cancel
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@server’
Scheduling Data Transfers

Choose the user ID to run the task

Scheduled Task Wizard [ x]
Enter the name and password of a user. The task will
run as if it were started by that user,
Enter the user name: myuiserid
Enter the password: =
Confirm password: =
< Back Cancel

©2005 IBM Corporation
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Scheduling Data Transfers

Verify summary information

Scheduled Task Wizard [ ]

‘fou have successfully scheduled the following task:
Update Customers Daily

“Windows will perform this task:
Ab8:00 AM every day, starting 9/7/2003

& Hipen advanced properiss for s iask when | cick:
Finish,

Click Finish to add this task to pour Windows schadule:

< Back I Finigh I Cancel
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Scheduling Data Transfers

Add the transfer request to run

Update Customers Daily [ 7]x]

Task | Schechie| Settings | Securty |

° MOdIfy the Run I|ne tO InC|Ude the ﬁ C:WWINNTAT askshUpdate Customers D aily. job
transfer you want to run

Bur: I:cess\lflumpcb exg” T empidtranstermpcustomers. dit”

Browse

Startin I"C.\ngram Filesh BM4Client Access

Comments. ’

Fiun as: myuserid Set password,

[¥ Enabled [scheduled task runs at specified time)

aK I Cancel Apply

©2005 IBM Corporation
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Scheduling Data Transfers

Viewing scheduled tasks

B3 Scheduled Tasks (- [O]x]

File Edit Wew Favorites Tools Advanced Help |

EBack » = - | Qizearch [YFolders £ | [ X & | Eg-

Address |(E) Schedued Tasks 2| P
1 ekt =1 Name_# | Schedule | Nexk Run Time I Lask: Run Time I Skatus
B Add Scheduled Task

[ Llpdate Customers Daily AbE:00 AM every d...  8:00:00 &M ... Mewver
Scheduled Tasks

This folder contains tasks you've
scheduled For Windows, Windows
sutomatically performs each task at
the scheduled time,

Far example, you can schedule a time
For windows to clean up your hard disk.
by deleting unnecessary files,

Select an item to view its description.

[l | ]
4

|2 abject{s) | ‘
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@server’
Data Transfer Usage

* Basic Data Transfer

* Running Data Transfer by Clicking an Icon
» Scheduling Data Transfers

* Using the Excel Add-in

» Using Data Transfer with a Web server

* Using the Data Transfer Query Builder

* Tips and Tricks with Data Transfer
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@server’
Using the Excel Add-in

Data Transfer from iSeries

Library: QIWS

.
Table: QCUSTCDT
EAMicrosoft Excel - Book1 [_ O] <]
] Fle Edt Wew Insert Format Tools Data Window Help =181 %

DS HERY sBBC|---- 8> supa80 209

Arial - 10 -

[ J [ kK [ L [ M [ M [ o [ P | a

Jeafe[ [ en e ]~

S

(]

[

1
14 4[»[pI\Sheet1 Sheetz [ Sheets /
Ready IT [

=
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@server’
Using the Excel Add-in lient AE
What is the Excel Add-in? ED

* Available with Microsoft Excel 97, Excel 2000, and Excel XP.
* Use this support by:

— Clicking on the Data Transfer upload or download button on the Excel toolbar
— Using the options on the Data menu bar

©2005 IBM Corporation
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@server’

Using the Excel Add-In

Installing the Excel Add-In
» Open Microsoft Excel

E3 Microsoft Excel - Book1

. CI|Ck Add-lns from the Eile Edit View Insert Fgrmat@gata Window Help ;Iilll
Tools menu D@ SRY[se¥ed. o bz plll @4 -0
i e T B | I AutoCarrect... ‘$ %, Wle] - &'i' ?‘
¢ Click the Browse... rO - ——
button A T B [ € rakchengs o F | G | H | I =7
. . 1 | Merge Workbooks, ,, Il
* Locate the path in which |2 et '
yOU insta"ed C“ent I Opline Collaboration  »
Access % Goal Seek...
= SCENAH0S. ..
. 7 S
* Double click on the B \ Ayting D
folder named 'Shared' |2 Mazo
+ Double click on the % N ey
. (414 7p vl Sheetr (Sheeta [ She
cwbtfxla file Ready Sl ] ] o o |
* Click the OK button
©2005 IBM Corporation -
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Using the Excel Add-In

Data Transfer from iSeries: Transferring data into Excel

. > EA Microsoft Excel - Book1
SeIeCt Data |G Fle Edt Yew Insert Format Tools Dats Window Help =181 x|
Transfer Data From/To  [hzpany seee- - wzrsz 080 Y08
iSeries | il -w - BIUE=E=H 3%, W8 = _-s-A-7
Al =2 =
[ J [ ®w v '™ [ ~N [ o [ P [ @ —
-or- 1 =
2
|3
. 2]
* Click one of the Data :
Transfer icons on the 7]
8
toolbar E
[10]
1"
12|
13 i
i3] =
i [4 ¥ mlSheett { Sheetz { sheets / 4IJJ—I
Ready |1 [ | | | A
©2005 IBM Corporation é
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Using the Excel Add-in

Data Transfer from iSeries: The Transfer Request panel

B3 Microsoft Excel - Book1 [_[O]x

File Edt Wiew Insert Format Tools Data Window Help =18 x
L] ~=l5] x|
DEEELY ipad~o- - ez a8 BB0 F0S
v B s %, 848 &u-a-A-2

Al

I N o ["F T @ 3
1] |
% Transfer Request [2]x]
4| Transfer Request
151 & [Cieats neve
16| )
[ 7] 1 Create fiom file (=.dtf, *to, *.dt. *.rta)
|8 | Browse..
19|
|10}
[ 11| Starting cell position
i ot % o [T
14
[[4]¥[M]\Sheet1 {Shestz £ Shests / ¥ Include column headings
Ready | [
0K | Cawel | Heb |
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Using the Excel Add-In

Data Transfer from iSeries: Creating a new data transfer request

Data Transfer from iSeries [ x]

System Name

Wihere is your data located?

iSeries server:

cpsce [ mets | Cancel Helps

@server’
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Using the Excel Add-In

Data Transfer from iSeries: Choose the file to download

Data Transfer from iSeries [ x]

i5eries File and Library

‘wihat library and filefs) contains pour data? For
example, IWS/ACUS T or
Qlws/QCUSTCOT. TESTLIB/TESTFILE.

“ou can browss for available librariss and filss
by pressing the brawse bution. Typing in the
library name: and pressing browss will Brawss:
the available fles in that library.

Library/File{Member]

Browse. |

< Back I Hext > I Cancel Help
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@server’

Using the Excel Add-In

Data Transfer from iSeries: Customize the Data Transfer request

Data Transfer from iSeries

Customize File Transfer
*ou can custamize how your data s transfered. By
default, all your data will be transfened

To select which data you want to transfer, press Data
Options.

Data Options

Ta change how your data s formatted, prass Fomat
Optiorrs

Format Dptions

Ta change rurvtime options, press Propettiss:

Properties...

<Beok [Tmes ] caed | Hep |
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Using the Excel Add-In

Data Transfer from iSeries: Customizing Data Options

Change Data Options

» Customizing Data Options allows you  “™

to set options like: el
— what fields are retrieved

Select [

— the ordering of the data |

— only retrieve data based on certain e |

conditions Having |
DOrder by:

A O 3 R T ] | KT

™ Retum recards with missing fields

™ Enable gioup functions

oK I Cancel Details Help
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Using the Excel Add-In

Data Transfer from iSeries: Customizing Format Options

Change Format Options HEBE

Date/Time | Decimals | Mise |

~Dd
Date format: o
Date separator  [[7]Glach B3| change Format Options
Date/Time  Desimals | Mise |
~Tim
Time format: = .
Ti [HMS] Hours Minutes Seconds x| Ml
. i i Change Format Options HEBE I
Time separetor  [1] Colon =
Decimal separator Date/Time | Decimals Mz |
S
Decimal separator: || Period |
[k | o | ooy | b Sot sequence:
Tiable:
- Languag

L ¥
’D—KI Cancel Ay Hel Language: iSeries Job Default
Language [D;

[ ok ] cenea | s | mer |
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Using the Excel Add-In

Data Transfer from iSeries: Customizing run-time options

» Conversions

— Allows for the enablement of special
data conversions and for error logging

e Library List
* Display
+ SQL
» Connection
— Can configure signon and security

Properties
Conversions | Library List| Display | AL | Connection | Startup |

Data conversion

wert CLSID BShaE
I™ Log pasition of untianslatable fields

= Breserve tabs

options
* Startup
— Can enable option to run transfer o] coed s e

request automatically later
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Using the Excel Add-In

Data Transfer from iSeries: Specify a file name

Data Transfer from iSeries

Save request to file

You can specify a file name to store your request
information

1F you save your request ta a file, you can run the
request again withaut having to reconfigure your

options.

IF you choose not to save the information to a file,

the information will only be used for the duration of
s request

File name

JE:Memphduanstert customerdata df Chimze

< Back Finish Cancel Help.
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Using the Excel Add-In

Data Transfer from iSeries: Viewing the results

[Erwosotonel gkt |
B Bie Edit wew Insert Fgrmat Joos Data Window Help ;|g|5|‘
IDERSRY sBRT - -c- @z st imse -3, 0a)
| aria - - HIH‘% |$%, %8 : &'A'~|
A1 | =
E | C D E [ F [ & [ H T 1 7 [ 3

1 [CUSNUMILSTNAM INIT STREET CITY STATE  ZPCOD  |CDTLMT |CHGCOD BALDUE COTDUE
[ 2 | 938472 Henning G K 4859 Elm - Dallas X 78217 &000 & 37
| 3 | 839283 Jones BD 218 NWY 11 Clay MY 13041 400 1 100
[ 4 | 392859 Vine S= PO Box 7S Broton WT 5046 700 1 439
| 6 | 938485 Johnson JA 3 Alpine Y. Helen GA 30545 9999 2 38875 33
| B | 397267 Tyron W E 13 Myrtle [Hector MY 14841 1000 1 1}
| 7 | 389572 Stevens KL 208 Snow Derver  CO 80226 400 1 5875 1
| B | 846283 Alison J3s 787 Lake [lsle MR 5h342 &000 & 10
| 9 | 475938 Doe J W 59 Archer Sutter CA 95685 700 2 260 10
[ 10  B93629 Thomas AN 3 Dowe CinCasper WY 82609 9999 2 1]
[ 11| 593029 Willams ED 485 SE 2 4Dallas X 75215 200 1 25
[12] 192837 Lee FL 5963 Dak Hector  NY 14841 700 2 489.5 i}
|13 583950 Abraham M T 392 Mill Stlsle MR 5342 9939 5| 500

14 hd
M4 [» (b Sheet1 { Shestz £ Shests K1 HLUJ
Ready I [ [T I [ [ A
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Using the Excel Add-In

Data Transfer to iSeries: Notes

+ Support for uploading data added in V5R1

 Support allows the following functions for transferring data to the iSeries:
— Create new file and member based on iSeries file

Create new file and member based on spreadsheet

— Create new member

Replace member

Append to existing member
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Using the Excel Add-in

Data Transfer to iSeries: Highlighting the data

Ed Microsoft Excel - Book1

&) Ele Edit Yiew Insert Format Tools Data Window Help

JNETE|
Dby |[smRad o o gz s tli@de -5, [Da)
| v -o-BrUSEEEEs %, B8 E5|_-5-A-
A1 | = CUSNUM
A B

13] 563990 Abraham MT 39 MillStlsls MM 56342 9898 3 S0 ol
1

|4 [4]» TM]Sheet1 {Shestz [ Sheets / JJ
Ready |1 Bum=r931948.25 | | [ A
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@server’
Data Transfer Usage

* Basic Data Transfer

* Running Data Transfer by Clicking an Icon
» Scheduling Data Transfers

* Using the Excel Add-in

* Using Data Transfer with a Web server
» Using the Data Transfer Query Builder

* Tips and Tricks with Data Transfer
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Using Data Transfer with a Web server

HTML File support - Updating a web server on iSeries

Data Transfer to

Workstation
HTML File
— Generated
"~ atPC

—2
Send HTML to iSeries
Web Server (file system)

Client browser
views HTML on
iSeries Web Server

"

Client PC
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Using Data Transfer with a Web server

HTML File support - Updating a web server on another machine

Data Transfer to

Workstation
n HTML File
-y —
— — Generated
—— atPC

Send HTML to
Web server

Client browser
views HTML on
Web Server

AlX or NT Web
Server
-

Client PC
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Using Data Transfer with a Web server

@server
Downloading a file to HTML
21 Data Transfer From iSeries [_ [0
File View Help
e =
- iSeri
System name:  [WYEYSTEM |
File name: QWS /QCUSTCOT

ﬂ Browse

Data Dpiars.
FC
Output device:  [HyperTent Markup Language (HTML) ¥|  Detaiks.
File pame: [Cetermphdtanshermpdata him Browse...
Format Options
‘ Transfer data from iSeries |
©2005 IBM Corporation
- -
iSeries pacer

[i[T] DEMAND BUSINESS®

Setting HTML properties

@server’
Using Data Transfer with a Web server

* File
* Document

HTML Details

— Specify a title and timestamp
* Table

File | Document| Table | Caption | Fiow | Cel | Template |
I~ Use auto sizing
T awimum file size: 128 KE
¥ Prompt before ovenrite
. . . Translation and charset
— Specify spacing, alignment, and other table -
roperties € asal
p ) p  UIF8
° Captlon Charset  [windows1262
— Specify whether to add a caption for your
table
* Row
* Cell 0K | Cancel Aol Help
* Template
©2005 IBM Corporation §
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Using Data Transfer with a Web server

HTML Template support - enhancing web pages

. . etails [2]x]
HTML Template allows iSeries tabular W =
data to be inserted into a pre- Fie | Document| Table | Caption | Row | Cell  Template |
formatted HTML document at a (24 Ul ool

specified location. The location is IT;::::;:‘:W .
defined by an embedded template e |
tag Embedded template tag:

|<\-- TABLET ~»

The template document may contain
graphics, links, frames, and any other
HTML elements you provide.

B I Cancel Apply Help
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Using Data Transfer with a Web server

Using HTML Template Files

<HTML>

<HEAD>

<TITLE>Sample HTML Code</TITLE>
</HEAD>

<BODY>

<H1>Customer Data</H1>

<l-- TABLE1 -->

</BODY>

</HTML>

When the transfer is run, the template file will be used as a base for the new HTML file.

When data is received from the iSeries, the data will be formatted and will inserted in place
of the <!-- TABLE1 --> tag.
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Using Data Transfer with a Web server

DATALINK data type support

Transferring the DB2 UDB for iSeries DATALINK type to a HTML
file will produce active links within your HTML File.

CUSTNAM | ADDRESS PHONE WEBSITE

IBM iSeries Rochester, MN 800-426-3333 | http://www.ibm.com/eserver/iseries/index.html

COMMON Chicago, IL 800-270-8223 | http://www.common.org/index.html
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Using Data Transfer with a Web server
Viewing the results
3 RC11ASD00 - WS/ CUSTEDS - Mirosot neernet oplorer =
Fle Edt Wew Favorites Tooks  Help |
addhess [B] Citempldiransferimpdata.bim =] @
CUSNUM LSTNAM INIT STREET| CITY [STATE |[ZIPCOD|CDTLMT|CE
038472 [Heming GK [5°°  IDallas [TX  [75217  [5000 3
Elm Ave
830283 lJones  BD f;?gw Clay [NY  [13041 400 1
392859  [Vine S S 1;;) Box |pooton[VT  |s046  [700 1
038485 [Johnson JA %‘:}{p‘"e Helen [GA (30545  |0999 2
13
397267 [Tyron  WE Myrtle [Hector NY 14841  |1000 1
Dr
[ [ [ lann [ [ [ [ [ hd
4| | »
|&] pone [T [ & My computer 7

©2005 IBM Corporation

iSeries (i[7] DEMAND BUSINESS®




@server’
Using Data Transfer with a Web server

Movement of data

- Data Transfer may be used as an data utility in e-business processes.

— May be used to upload gathered transactions to the iSeries from a PC server
acting as the e-business interface.

— May be used by CGI programs on the PC Server to build standard PC files
which may then be sent to customers through the web.
— May be used to generate HTML files to be published on a web server.

— ActiveX objects (or RXFERPCB) may be used in 3-tier to run data transfer
from a Windows Web Server.

©2005 IBM Corporation
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Data Transfer Usage

* Basic Data Transfer

* Running Data Transfer by Clicking an Icon
» Scheduling Data Transfers

* Using the Excel Add-in

» Using Data Transfer with a Web server

» Using the Data Transfer Query Builder
* Tips and Tricks with Data Transfer
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Using the Data Transfer Query Builder

Starting the Data Transfer query builder

Elr [_C]
Fle Wiew Help

&= || e

System name: |MYSYSTEM

File name: - Erowse...

{"Diata fptions.

L

1 1

FC

Dutput device: |D.SD\E,. =l Details
File name: [ Biowse
Format Optiors...

Tiansfer data from iSeries |

©2005 IBM Corporation
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Using the Data Transfer Query Builder

Setting up a query

Change Data Dptions

Join by

Enter "SQL-like"
statements directly
into the edit panels

Group by

Select

OR - |

Having |

Click on Details... to ity

bring up the Data
Transfer query builder Rsturn racords with missing fiskds
™ Enable groty 4

0K | cancel | Detels. | Hep

I ) K | T [ K| KK
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Using the Data Transfer Query Builder

Select fields to transfer from the iSeries

Double click on field
names in the field list
to add them to the
Select clause.

Functions such as
SUM may also be
used to return
functional results

Receive Request Details

Select | where | Drder By |

—_—

M
MIN
crik

@server’

Field [ Deseiipion [ Tupe [ Lengh[ Digi[1~
COSNUM CUSTOME..  ZONED g €
LSTHAM LAST MAM.. CHAR g o
INIT FIRST AND.. CHAR 3 o
STREET STREETA. CHAR 13 o
oY CTYFIELD  CHAR g 0
STATE STATE ABB.. CHAR H 0=
4 | »
Eunction
AVG =
COUNT

Seleet clause

ok | cencal | sy | Hen |
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Using the Data Transfer Query Builder

Creating a where clause

Specify conditions on data
transferred from the iSeries by
building a where clause.

Double click on a field name or
specify a function, then specify a
test condition by double clicking on
a test operator. Enter the right
side of the comparison in the
comparison dialog.

Receive Request Details

Select Where | Drder By |

@server’

Field [ Description [ Tvpe [ Lengh[ Digi[ 1
I CUSTOME..  ZONED 6 5
LSTNAM LAST MAM .. CHAR g i
IHIT FIRST AND... CHAR 3 0
STREET STREETA. CHAR 13 i
oTY CITYFIELD  CHAR & i
STATE STATE ABB.. CHAR 2 0 ox
| | »
Mot Eunction: Test Others:
NOT | [CHeR i’ B f’ £145
CURRENT <= R
DATE <>
e =B Al
where clause:
(LSTNAM = Henning] =l
0k | caneed | v | Heb |

©2005 IBM Corporation

iSeries

PAGE 78

@ DEMAND BUSINESS™




@server’

Using the Data Transfer Query Builder

Ordering data

An Order By clause may be
specified to order data transferred
from the iSeries.

Fields may be ordered in
ascending or descending order by
specifying either ASC or DESC
after each field name. Currently,
on the iSeries, fields used in the
order by must also exist in the
Select clause.

Receive Request Details [ 7] =]
Select | Where OrderBy |
~Oider b
Field [ Description [ Tupe [ Length| Digt] 1=
CUSHUM CUSTOME..  ZONED 3
LETHAM LAST NAM... CHAR g i
INIT FIRST AND..  CHAR 3 g
STREET STREETA. CHAR 13 0
oY CTYFIELD  CHAR 5 0
STATE STATE ABB.. CHAR H 0 -
4| | »
Eunction: Others
WV = ] B
COUNT :I . B
M ase
il =l =
Ordder by clause:
CUSNUM DESC =]
0K | Cancel | ook | Heb |
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Using the Data Transfer Query Builder
Muilti-file joins
Receive Request Details [ 2] x]
When multiple files are specified Select| Where | Order By Jain By |
for download on the main Data ~Jsin
Transfer panel, a join clause may Field [ Desorption [ Twpe | Lengh] _ Digt] (=
. ey . T1.CDTDUE CREDITDU... ZONED B 3
be built to conditionally join T2EUSHUM LONG 4 3
records across multiple files. il o 50
TZ5TREET CHAR 13 1)
T2OTY CHAR [ o -
4| | _’I—I
Test Others:
< AND
<:E|
<
o |
Join by clavse:
T1.CUSNUM = T2 CUSNUM ;I
- |
Tk ] Caeel | gy | Hee |
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Record grouping

If Group By functions are enabled on

the Data Options panel, a Group By

statement may be specified to group
records that are returned.

@server’

Using the Data Transfer Query Builder

Receive Request Details HEBE

Select | Where | Having | Order By Group By |

(- Giroup B
Fied [ Description [ Tope [ Lengh[ Digt[t=
CUSHOM CUSTOME.. ZONED 3 g
LSTHAM LAST NAM... CHAR 8 0
INIT FIRSTAND... CHAR 3 0
STREET STREETA.. CHAR 12 0
CITYFIELD  CHAR E 0
STATE STATE ABB.. CHAR 2 0 -
4| | »

Group by:

CITY =1

0K | Cancal | pow | Hen |
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Using the Data Transfer Query Builder
Conditional grouping using Having
Receive Request Details [ 7] =]
Conditional record grouping from a Seloct | et Ha | er By | Groun 8|
Group By operation may be done by [Hevra
f . H . I Mot Eunction: Test: Function: Others:
spec' ylng a aVIng clause. NOT i < <constanty B
L] OR
(15 COUNT
MIN Max
SUM MIN
SUM
Hawing clause:
[COUNT[*1=1) ;I
-]
Cancel | Apoy | Hep |
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Using the Data Transfer Query Builder

@server
Activating the Native SQL Interface
ata Transfer From iSeties [_ 1]
A Native SQL interface is [Properties _________HIEi[=
provided for power users or C | Library List| Display SHL | Connection | Startup| |—
for situations where the [ Beies 50l aption I
Data Transfer format does LA | | ) e SIS B e e
not provide enough Flerame ™ | @ Fiscss SELECT a5 iata 500 |
functionality
e |
Dutput de J
File: riame J
L 0K | Caneel | popy | ben ||
il
©2005 IBM Corporation
iSeries PAGE 80

[i[T] DEMAND BUSINESS®
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Using the Data Transfer Query Builder
Finding the Native SQL Interface
21 Data Transfer From iSeries H[E 3
After choosing to process e ] ﬂe‘
your statement as Native LA
SQL, the Data Options .
button activates a Native Systemname:  [MYSYSTEM =
SQL panel File: niame: Imwszucusmm JE [
|
\ Data Optians. .
—FC
Output device: — [Display = Deis..
File name: | Browse..
Farmat Options.
| Transter data from iSeriss I
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Using the Data Transfer Query Builder

Using the Native SQL Interface

24 Data Transfer From iSeries

—Fl?l
X File View Help Change 501 Select Dptions [ 7] =]
The Native SQL H
. DS E|E
interface allows you to
type in a free form [ iSeries
SELECT statement. A S
list of files and columns File name: =
in those files are
provided to help you BB e | —
build your statement T EE 1
rPC LSTHAM LAST MNAM, CHAR a8
INIT FIRST AMD... CHAR 3
Quiput devie: | STREET STREETA. CHAR 13
CITY CITY FIELD CHAR [ =2
File name: 1 | _’|_I
Librarp/File[Mbr):
GIWS/QCUSTCDT

0K | Cereel | Heb
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@server’
Data Transfer Usage

* Basic Data Transfer

* Running Data Transfer by Clicking an Icon
» Scheduling Data Transfers

* Using the Excel Add-in

» Using Data Transfer with a Web server

* Using the Data Transfer Query Builder

* Tips and Tricks with Data Transfer

©2005 IBM Corporation
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Tips and Tricks with Data Transfer

* Renaming a column

» Reordering columns

* CAST’ing a column

+ Scalar functions

» Working with date/time/timestamp fields

©2005 IBM Corporation
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@server’

» Take advantage of all the ways you can use Data Transfer
— Running requests by clicking an icon
— Scheduling data transfers
— Using the Excel Add-in
— Using with a web server
— Running advanced queries
— Using ActiveX Automation Objects
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iSeries Access for Windows — Sessions in Chicago

26GH - MS Office with Client Access

31GJ - Administration of iSeries Access for Windows: Advanced Tips

31GH - MS Office and Client Access Integration Session 1: Setup and Overview
32GH - MS Office and Client Access Integration Session 2: Word and Excel

33GH - MS Office and Client Access Integration Session 3: Access-Web-Sending
Data

apoOb=

6. 36CA - iSeries Access for Windows: What’s New in V5R3

7. 41CB - iSeries Access Data Transfer: Tips and Techniques

8. 41LC - LAB: MS Office with CA/400

9. 42CB - iSeries Access for Windows: Security and Communications Tips
10. 44CA - iSeries Access for Windows in a .NET World

11. 45LA - OPEN LAB: iSeries Access for Windows with the Experts

12. 52CB - Everything you wanted to know about PC5250 emulation

13. 56CB - Performance Tune iSeries Access ODBC Driver
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@server’

Session title: Using iSeries Access Data Transfer

Session ID: 409159

Agenda Key: 23Cl

Speakers:  Brent Nelson
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Appendices

» Components of a Data Transfer Notes
» Administering Access to Data Transfer
 Data Transfer ActiveX Automation Objects

©2005 IBM Corporation
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Components of a Data Transfer

» Data Transfers involve 4 basic components
— PC File

— An iSeries Database or Source Physical File
— File Description File (FDF)

— New or existing transfer request

©2005 IBM Corporation
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@server’

Components of a Data Transfer

Component I: The PC File

+ A PC file is a standard "flat file" located on (or to be created on) your
network or workstation.
 Data Transfer supports many popular PC file formats
— Lotus 1-2-3 (.123) and Lotus 1-2-3 version 4 (.wk4)
— ASCII Text (.txt)
— Basic Random and Basic Sequential
— Microsoft Excel (BIFF) versions 3, 4, 5, 7, and 8 (.xls)
— Comma Separated Variable (.csv)
— Data Interchange Format (.dif)
— DOS Random, including type 2
— Tab Delimited Text (.txt)
— No Conversion (EBCDIC)
— Hypertext Markup Language (.htm, .html)

©2005 IBM Corporation
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Components of a Data Transfer: Supported PC File types

Data Transfer supports many popular PC file formats when transferring data to or from the iSeries.
However, some rules apply when performing a data transfer, especially uploading data to the iSeries.

Download
m The PC file type to download to must be able to hold the data from the iSeries file. For example,
downloading to a BIFF3 (Excel version 3) file limits character fields to 256 characters and only allows
16,385 rows in a spreadsheet.

Upload
m If uploading to an existing iSeries file, the format of the data in the PC file must match the format of
the data in the iSeries file.
m If the PC file has column names those names must match the names in the File Description File and
the iSeries file.
m The HTML file type is not supported for upload.
m Uploading to a database file (table) requires that you have a File Description File (FDF) to match your
PC file.
Uploading to a source physical file with a file type other than ASCII text will only send the first column of
data from the PC file. If more than one column exists in the PC file, you will get a message stating that
extra data was found at the end of the file and will be truncated.
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Components of a Data Transfer

Component II: An iSeries Database or Source Physical File

Transferring data to or from the iSeries requires you to specify either a database table(s) or
source physical file. Each of these file types may contain multiple members.

Database File

An iSeries file in the form of a relational table. It has a specific layout composed of various
types of columns with various lengths.

Source Physical File
An iSeries file normally contains 3 columns. A SRCSEQ, SRCDAT, and SRCDTA column.
The first column is a sequence number. The second column is a date, and the last column

contains your data. The first two columns are six bytes each, and the last column may be
variable length.
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Components of a Data Transfer

Component Ill: The File Description File (FDF)

A file description file (FDF) is a PC file used to describe a PC data file. A file description file is
required when transferring data to a database file on the iSeries.

An example file description file:
PCFDF

PCFT 19

PCFO 1,1,1,1,1

PCFL Name 1 8

PCFL Address 1 13

PCFL Zip 26

PCFL Phone 1 8

PCFL Balance 2 8/2
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Components of a Data Transfer: File Description File (FDF)

The PC File Description File (FDF) contains various record types.
The first line of an FDF file must contain PCFDF. This line indicates that the file is an FDF.

The next line of the file, PCFT, indicates the PC file type. File type 19 signifies an FDF for use with the
Lotus 123 Version 9 file type. Values for other file types are as follows:

ASCIl Text = 1 Dos Random = 2 BasicSequential = 3 Basic Random = 4

DIF =5 No Conversion = 6 Dos Random =7 Dos Random Type 2 =8
BIFF 4 =9 BIFF3 = 10 BIFF5 = 11 CSV =12

Lotus WK4 =13 Tab Delimited Text = 14 BIFF7 =15 BIFF8 = 16

Lotus 123 = 17 Excel Add-in = 18 Lotus 123 Version 9 = 19

The PCFO line indicates PC file options. These options include date and time formatting and the decimal
separator to use.

The PCFL lines contain the fields of the PC file. These are in order, top to bottom, listing fields in the PC
file. The first column is the field name, for example, Address, the next column is the data type, and the
final column is the length. The most common data types are '1' for character and '2' for numeric. The
third column may contain two numbers separated by a '/'. This indicates that the field has numeric scale.
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Components of a Data Transfer

Component IV: The Transfer request

* What is a transfer request?

— A transfer request is a PC file created by and used with Data Transfer for
storing options and settings for the transferring of data to or from the iSeries.

» Some of the items stored in a transfer request include:
— iSeries system name
— iSeries file name(s)
— PC file name
— PC File Description File name
— PC file type
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* Some options include:
— Microsoft System Policy support
— Application Administration
— Exit Programs
— Object-level database security
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g Microsoft System Policies

FOLEDIT.EXE

 Data Transfer From iSeries - Limiting
downloads

— Prevent usage of Data Transfer From
iSeries

— Prevent usage of Data Transfer GUI

— Prevent usage of RTOPCB command

— Prevent autostart uploads

— Prevent usage of Excel-Add In

* Limiting users to only autostart

downloads will help to prevent them from
modifying transfer requests and keep
them from downloading any file they have
read access to on the iSeries.
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£3 Default User Properties

Policies |

£\ 1BM iSeries Access Runtime Restrictions
2|0 Data Transter
-4 Data Transfer Uploads
[ Prevent all Data Transfer to server
. [=)-4® Data Transfer uploading options
-0 Dats Transfer Dowrloads
i [ Prevent all Data Transfer from server
=) Data Transfer downloading options
: Prevent Data Transfer GUI Downloads
Prevent usage of RTOPCE
Prevent autostart dowrloads
: Prevent Excel addin downloads
- Server fie crestion
@ Directory Update |

L

Cancel
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g Microsoft System Policies

£ Default User Properties [ 2] x]
POLEDIT.ERE e |
« Data Transfer To iSeries - Limiting E] @g\A[;SenETSAccfessHunl\mEHestnclmns =
= ata Transfer
u ploads -4 Dsta Tramsfer Uploads
— Prevent usage of Data Transfer To e Tl ok oo
iSeries [ Prevent appending/ieplacing host files
. . [ Frevent Data Transfer GUI Uploads
— Prevent appending to/replacing host Fievet usege of FFRONPCR
files S
— Prevent usage of Data Transfer GUI A -
— Prevent usage of RFROMPCB = @ Dala Transfer downloading options
command @ Serve file creation =l
— Prevent autostart uploads
+ Limiting users to only autostart uploads
will help to prevent them from modifying
transfer requests and keep them from —

using Data Transfer in potentially
harmful ways.
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g Microsoft System Policies
£ Default User Properties [ 2] x]
FOLEDIT.EXE e |
» Data Transfer To iSeries - iSeries server = [~W@e D e B s Pt 5|
file creation @ Data Tiansfer Uploads
@ Data Transter Downlnads
— Prevent creation of new files on the S .
i Tl File creation options
ISerIeS c i Plavtenl saprtvel file creation based on PC fil
— Prevent creation of files via the Data EJ-% Dua::;p:':n\:m serve fils creation based or sxisti
-8 Passwords
Transfer -8 iSeries Navigator
E

« Create iSeries Database File wizard g Comniceins | _,ﬁ'
— Prevent creation of files via the standard

« "created based on" or Field Reference
File method.
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Getting a system setup for policies

1. Get the System Policy Editor from http://www.microsoft.com.

2. Open an MS-DOS window.

3. Go to the iSeries Access for Windows directory, normally located at:
[C:]\Program Files\IBM\Client Access\

4. Run the cwbadgen /std command in the MS-DOS window. This

generates the caerestr.adm policy template needed to create the policy
file.

Note: for more information on policy support see:
http://publib.boulder.ibm.com/iseries/v5r2/ic2924/info/rzaii/rzaiiconfiguration.htm
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Getting a system setup for policies

1. Start the policy editor by double-clicking on poledit.exe.
2. Go to Options > Policy Template > Add.
3. Go to the location where you stored the .adm files that you created in creating
policy templates.
4. Select the .adm files that you want to add and press Add. Keep doing this until
you have added all the .adm files you want to use. Click OK.
5. Select File > New Policy.
6. Set your policies and save the policy file:
1. \QYOURSYS\POLICIES\config.pol (for Windows 95/98) -or-
2. \QYOURSYS\POLICIES\ntconfig.pol (for Windows NT)
7. Where:
QYOURSYS is the name of your iSeries NetServer.
POLICIES is the name of the shared file folder on your iSeries NetServer.
(nt) config.pol is the name of your policies file.
To update the policy file, open your policy file with the policy editor, make your changes and
save the file back to the above location.
* Note: You must create and maintain policies for the Windows 95/98/Me and Windows

NT/2000 separately. (Policies created for Windows 95 will not work on an NT system, and
vice-versa.)
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Administering Access to Data Transfer

iSeries Navigator Application Administration

Application Administration {Local Settings) - Rchasdsb

* To get to Application S ST
Administration: Fes Navigao Dt Agpicatins | Host aglcaons |
. Open ISerIeS Navlgator : Default Access AIIDh'ecccess Customized Access | &
* Click on the system you T e
want to administer o0 B Denricads
« Go to the File menu S
B0@ Active Automation Dowrloads
and select Application R i
Administration -> Local o e
Settings e =
A ¥
Remowe Customization Custoniize
Applications [k | canea | He |
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Administering Access to Data Transfer

iSeries Navigator Application Administration

» Application Administration
— Provides similar capabilities as Microsoft PC based policies
— Administration information is stored on the iSeries
— Data Transfer options are stored on a per user/per iSeries basis
— Customize user access to Data Transfer functions
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iSeries host server exit programs
» Exit Programs
— Exit programs written for the QIBM_QZDA NDB, ROI, and SQL exit points
may help to restrict certain users from accessing specific files.
— Configured with WRKREGINF on the iSeries
— Given the SQL statement sent from the client application (Data Transfer).
Statements may be rejected by the user exit program
— May be written in a variety of host languages

Note: Data Transfer and ODBC use the same server for database access.

Currently, exit programs created for Data Transfer are also active for ODBC
users.
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Object-level database security

« All objects on the server, including SQL objects, are managed by the
system security function

» See:

http://publib.boulder.ibm.com/iseries/v5r2/ic2924/index.htm?info/sqlp/rbafymst324.htm
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ActiveX? Automation Objects? So what's this? What can they do for me?

ActiveX Automations are re-usable objects that reside on your

Windows PC. Many times they can be used to run an application by
"remote" with a program or script.

They work similarly to Object Linking and Embedding (OLE), used
for things like inserting an Excel spreadsheet into a WordPad
document. Not just cutting and paste, actually "linking" the
spreadsheet into the document.

ActiveX objects work much like this, except in the programming world.
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So what can they do for me?

ActiveX automations can be used to quickly and easily perform many tasks
with little or no user intervention. For example, a program may use the
Automations for Microsoft Excel to perform various data calculations
without ever bringing up the Excel interface.

ActiveX automations can be used to create new custom interfaces
over applications that have ActiveX automations. A few examples are
Microsoft Office products, Internet Explorer, the PC5250 emulator, and
various iSeries Access for Windows functions.
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OK, how do I use them?

 ActiveX automations are supported by many programming languages
including:
— Visual Basic
— Visual Basic for Applications (used by Microsoft Office)

— Visual Basic Script (used in web pages and the PC5250 emulator)
— C++

— Java
— Lotus Script
— Many other applications and development environments

* You must write program code to use these objects. Or allow some
development tool to write the code for you.

©2005 IBM Corporation

iSeries

[i[7] DEMAND BUSINESS®

@server’
Data Transfer ActiveX Automation Objects

What Automations are available for Data Transfer?

» Two types of ActiveX Automations for Data Transfer
— High Level Automations
— Low Level Automations

« Labeled based on functionality and ease of use
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High Level Automations

Easier to use, but limited functionality!

With the high level automations you can run a Data Transfer with as little as 2 lines
of code!
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The High Level Automation Object

The name of this object is DatabaseTransfer

The DatabaseTransfer object can be used to run a simple upload, download,
or an existing transfer request file!
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Using the Database Transfer Object

These two lines of Visual Basic (VB) code can be used to run a download:

Dim dt As New cwbx.DatabaseTransfer
dt.Download "mysys", "qiws/qcustcdt”, "c:\myfile.xls", cwbdtBIFF5

To do an upload:
dt.Upload "mysys", "cwbxtest/qcustcdt"”, "c:\qcustcdt.txt", "c:\qcustcdt.fdf"

To run a saved request:

dt.Transfer "c:\qcustist.dtf"
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Using the Database Transfer Object

The DatabaseTransfer automation object also contains properties
you can query or set for the transfer request.

* Errors - for query only. A standard collection of error messages.
Messages get put into this collection while the request is running

» Password - Allows you to set the password for the iSeries connection
necessary for the transfer

 TransferResults - Allow you to get the number of rows transferred,
return codes, and error and warning locations.

» UserID - Allows you to set the user ID to use for this transfer request.
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The Low Level Automation Objects

* There are two main Low Level Objects:
— DatabaseDownloadRequest
— DatabaseUploadRequest

* Various properties must be set on these objects to perform an upload or
download

» Used with other Client Access Express Automation objects.

©2005 IBM Corporation

iSeries

(i[7] DEMAND BUSINESS®

@server’
Data Transfer ActiveX Automation Objects

Using the DatabaseDownloadRequest Object

The DatabaseDownloadRequest object can be used to programmatically perform
a download from the iSeries to a PC workstation. It contains 5 additional objects

that may be set to perform a download. Each of these objects has various
settings.

« DatabaseAS400File - Stores the name of the file or files to download.

« DatabaseDownloadPCFile - Stores the name of the PC file to download, plus
file options.

« DatabaseQuerySettings - Query settings for the download.
« DatabaseFormatOptions - Data/time format options.

« DatabaseUserLibraryList - A list of libraries to use with the request.
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DatabaseDownloadRequest Object Methods

The DatabaseDownloadRequest object has several methods to perform various
tasks:

Download - Run the configured download

DownloadAsync - Runs the configured download asynchronously
LoadRequest - Used to load a stored download request
SaveRequest - Used to save the current request

Cancel - Cancels a running Async request
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A simple Visual Basic program to run a download using the low level
DatabaseDownloadRequest object:

Dim dir As New cwbx.DatabaseDownloadRequest
Dim myiSeries As New cwbx.AS400System
myiSeries.Define "mysystem"

myiSeries.UserID = "myUserID"
myiSeries.Password = "myPassword"

Set dIr.System = myiSeries

dir.AS400File = "giws/qcustcdt"

dir.pcFile = "c:\myfile"

dir.pcFile.FileType = cwbdtBIFF8

dir.Download
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Using the DatabaseUploadRequest Object

The DatabaseUploadRequest object can be used to programmatically perform an upload

to the iSeries from a PC workstation. It contains 3 additional objects that may be set to
perform an upload:

« DatabaseAS400File - Stores the name of the file or files to download.

DatabaseUploadPCFile - Stores the name of the PC file to upload, plus file options.
DatabaseUserLibraryList - A list of libraries to use with the request.
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DatabaseUploadRequest Object Methods

The DatabaseDownloadRequest object has several methods to perform various tasks:
o Upload - Run the configured upload

UploadAsync - Runs the configured upload asynchronously

LoadRequest - Used to load a stored upload request

SaveRequest - Used to save the current upload request

Cancel - Cancels a running Async request
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Asynchronous Methods

The DatabaseDownloadRequest and DatabaseUploadRequest objects have
asynchronous capabilities. This means the upload or download request can run "In
the background" while program execution continues. A running Async request may
also be cancelled by the main program.

The UploadAsync and DownloadAsync methods also pass events back to the
running program. These events are:

o StatusChanged - Indicates that something has changed, like the request has
completed, or there was an error, or a specific number of rows has been
transferred.

« UploadComplete - Indicates that an upload completed

« DownloadComplete - Indicates that a download completed
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Additional Information on the iSeries Access for Windows ActiveX automation objects can be
found in the iSeries Access for Windows Toolkit.

This information can be found under the ActiveX section of the Database portion of the Toolkit
documentation.
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Sample Code Disclaimer

This material contains IBM copyrighted sample programming source code for your
consideration. This sample code has not been thoroughly tested under all conditions.
IBM, therefore, cannot guarantee or imply reliability, serviceability, or function. IBM
provides no program services for this material. This material is provided "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING,
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF FITNESS FOR A
PARTICULAR PURPOSE, OR NON-INFRINGEMENT. SOME JURISDICTIONS DO
NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE
EXCLUSIONS MAY NOT APPLY TO YOU. IN NO EVENT WILL IBM BE LIABLE TO
ANY PARTY FOR ANY DIRECT, INDIRECT, SPECIAL OR OTHER CONSEQUENTIAL
DAMAGES FOR ANY USE OF THIS MATERIAL INCLUDING, WITHOUT LIMITATION,
ANY LOST PROFITS, BUSINESS INTERRUPTION, LOSS OF PROGRAMS OR
OTHER DATA ON YOUR INFORMATION HANDLING SYSTEM OR OTHERWISE,
EVEN IF EXPRESSLY ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
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Trademarks and Disclaimers

8 IBM Corporation 1994-2005. All rights reserved.
References in this document to IBM products or services do not imply that IBM intends to make them available in every country.

The following terms are trademarks of International Business Machines Corporation in the United States, other countries, or both:
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eServer IBM (logo)
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Rational is a trademark of Interational Business Machines Corporation and Rational Software Corporation in the United States, other countries, or both
Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.
Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both.
Intel, Intel Inside (Iogos), MMX and Pentium are trademarks of Intel Corporation in the United States, other countries, or both
is a registered trademark of The Open Group in the United States and other countries.
SET and the SET Logo are trademarks owned by SET Secure Electronic Transaction LLC.
Other company, product or service names may be trademarks or service marks of others,

Information is provided "AS IS" without warranty of any kind.

All customer examples described are presented as illustrations of how those customers have used IBM products and the results they may have achieved. Actual environmental costs and performance
characteristics may vary by customer.

Information concerning non-IBM products was obtained from a supplier of these products, published announcement material, or other publicly available sources and does not constitute an endorsement of
such products by IBM. Sources for non-IBM list prices and performance numbers are taken from publicly available information, including vendor announcements and vendor worldwide homepages. IBM
has not tested these products and cannot confirm the accuracy of performance, capabity, or any other claims related to non-IBM products. Questions on the capability of non-IBM products should be
addressed to the supplier of those products.

Al statements regarding IBM future direction and intent are subject to change or withdrawal without notice, and represent goals and objectives only. Contact your local IBM office or IBM authorized reseller
for the full text of the specific Statement of Direction.

Some information addresses anticipated future capabilities. Such information is not intended as a definitive statement of a o specific levels of function or delivery schedules with
respect to any future products. Such commitments are only made in IBM product announcements. The information is presented here to communicate IBM's current investment and development
activities as a good faith effort to help with our customers' future planning.

Performance is based on measurements and projections using standard IBM benchmarks in a controlled environment. The actual throughput or performance that any user will experience will vary
depending upon considerations such as the amount of multiprogramming in the user's job stream, the 1/0 configuration, the storage configuration, and the workload processed. Therefore,
no assurance can be given that an individual user will achieve throughput or performance improvements equivalent to the ratios stated here.

Photographs shown are of engineering prototypes. Changes may be incorporated in production models.
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